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Abstract 

The journal is intended for researchers and specialists active in the following research areas: diffractive optics; optical information technologies; nanophotonics and nanostructure optics; image analysis and understanding, pattern recognition; geoinformation technologies; digital image/signal processing, information coding and protection. In accordance with decision N. 6/6 of the Presidium of the Higher Certifying Commission (VAK) of the RF Ministry of Education and Science of 19 February 2010, the journal of Computer Optics has been included into the VAK list of peer-reviewed journals and periodicals where key research results obtained as part of a degree thesis must be published.
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Introduction
The journal is included into the database of the Russian Science Citation Index (RSCI), with its 2013 RSCI impact-factor being 0.271. All the issues of Computer Optics since 1987 are also presented electronically on the website of the Scientific eLIBRARY (SEL, www.e-library.ru) and on the Journal website at http://www.computeroptics.smr.ru.

Manuscripts, suggestions and comments should be submitted electronically to the Editorial Board at ko@smr.ru. In the email subject line, please indicate the topic of your correspondence. In particular, when submitting a research paper, indicate its title and author(s). Our telephones: +7(846) 3325622 (issuing editor), +7(846) 3325783 (editor), and fax: +78463325620 (secretary).

Current guidelines for authors of the journal of Computer Optics can be found at http://www.com​pu​ter​op​tics.smr.ru/ENG/guidelines.htm. In the process of manuscript preparation, authors are strongly encouraged to use style templates that can be downloaded from our website.

The Editorial Board requests authors to adhere to the present guidelines when submitting the manuscripts. Papers that do not comply with the current guidelines are not considered. Manuscripts and accompanying documents are not returned. The date of receipt of the final version is considered the date of manuscript's submission. 
The Editorial Board will not consider manuscripts sent personally to a Board member. 
The journal of Computer Optics publishes review articles, research papers, and brief communications on the following topics: diffractive optics; information optical technologies; nanophotonics and nanostructure optics; image processing, analysis, and understanding; geoinformation technologies.

The materials should contain new research results that are not currently under consideration for publication elsewhere. The paper must contain a clear statement of the problem, description of research methods, research findings and application areas. 

An Editorial Board's request to make a revision does not automatically imply that the manuscript has been accepted for publication, as the revised version is to be reevaluated by the reviewers and the Editorial Board. 

The publication is free of charge for the authors. The royalties are not paid. The manuscripts are not returned. 

The manuscripts should be submitted in Russian or English in an electronic form in the MS WORD 200/XP/2003 (.doc or .rtf) format together with a PDF copy (144dpi). The recommended length is up to 10 pages. 
For multi-author articles, a scan of the first page of the manuscript signed by all the authors should be submitted as a separate file. 

For the manuscripts accepted for publication, the proof-reading process is not supposed to change the number of pages and the general meaning of sentences. Once the proof-read copy has been obtained, no further amendments can be made to the manuscript. 
For the manuscript to be accepted for the review, make sure to include the following. 
1. At the beginning of the manuscript 

1.1. Title.
1.2. Author(s).

· Authors' first and middle initials and surname(s).
· Authors’ affiliations. If all the authors are with the same employer, there is no need to separately give their affiliations.
1.3. Abstract. It should be informative, (i.e. without generalities), substantive in nature (i.e. represent the major content of the manuscript and results obtained), well-structured (i.e. follow the logic of the results description in the manuscript). The Abstract must describe major objectives of the research, explain the methodology used (without details); summarize key results and their significance. The recommended length of the Abstract is 150 - 250 words. Mathematical formulae, references, Greek letters and abbreviations should be avoided.  
1.4. Key words: for subject areas of diffractive optics; optical information technologies; nanophotonics and nanostructure optics at least three key words should be taken from the Optical Society of America (OSA) database at http://www.opticsinfobase.org/oe/submit/ocis.
1.5. Cite as article citation format (including DOI).
2. Text. Your manuscript should be arranged as follows: Introduction (not numbered), Main text (may be divided into numbered Sections and sub-Sections), Conclusion (not numbered), Acknowledgements (if appropriate, not numbered), and List of References (in the RSCI format).
3. At the end of the article, provide a brief biographical sketch (10 – 15 lines) for each contributing author, including

· First names and surname in full;

· Scientific degree;

· Academic rank, position, affiliation (for each position held);

· Research interests (up to 15 words); 

· Email address; and
· Postal address (not published).

Page layout
The manuscript should be typed on A4 pages with a book-style (portrait) layout. Use mirror margins. Margins: upper- 25 mm, lower- 30 mm, inside- 23 mm, outside- 17 mm. Page header- 15 mm, page footer- 20 mm, with the page headers and footers of even and odd pages being different.
Text
The main text should be set in two equal-width (82 mm) columns separated by a 6-mm spacing (the separator should be enabled) using the standard style: 10-point Times New Romans font, a 5-mm paragraph indent, full formatting. Use automatic hyphenation. For indention, use the Format → Indent function. Do not use blanks when starting a new line. Extra blanks between words in the text and paragraph skipping within the same section are also inadmissible.
The paper title is typeset in 10-point Times New Roman Bold font, full-page width, centered, upper case, and paragraph indent- 0-mm. Do not use full stop. 

Author(s) full name(s), position(s), contact information (email address), and the institution name are typeset in 10-point Times New Roman Italic, single-column, centered, paragraph indent- 0-mm. 

The Abstract and Key words are typeset in 10-point Times New Roman font, single-column, left and right indents- 1.5 cm, paragraph indent- 0.5 mm. A comma or a semicolon separates each key word or word combination. 

Section headings are typeset in 10-point Times New Roman Bold-Italic font, column centered, 0-mm paragraph indent. Do not use full stop.

Math equations

Equations should be typeset in Microsoft Equation (not higher than 3.0 version) or MathType. Equations presented in MS Equation 2007/2010/2013 are not admissible. The formulae should be typeset with left 5-mm margin, left justification, 3-point margins on the left and right of the equation. Latin letters should be typeset in 10-point Times New Roman font and Greek letters should be typeset upright in 10-point Symbol font. Full editor’s settings are shown in Fig. 1.

We encourage you to typeset the in-text math and Greek letters using Tables of Symbols (Insert → Symbol → <choose the symbol> → Insert → Close). 

a) [image: image1]
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Fig. 1. Equation editor’s settings.
Formulae should be printed on a new line. Equations should be numbered consecutively at the right-hand margin, in parentheses.
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If the equation is too long to fit in the above-described length limit it can be typeset through the entire page width (up to 17 cm long, including the equation number), the margins being the same. Use the “single column” mode for such an equation. Complex formulae should be typeset as a whole and not in parts.

Illustrations (images)

All illustrations should be submitted as separate files linked to the document rather than being placed into the text. The images should be linked using the Word menu: “insert” – “picture” – “from file” (Fig. 2a); then, using “insert a picture” window, choose “link to file” from the pop-down menu “insert/ link to file/insert and link” (Fig. 2b).
The linking route to the image file must be relative, tracing the linked image file from the document to which it is to be linked. The image files should be named according to figure numbers in the body of the manuscript (e.g., 09.tif, 22b.jpg, or 22g.jpg). 

Illustrations should be placed directly after the text paragraph in which they are mentioned for the first time. Large-sized (full-page) illustrations are not encouraged (instead, we recommend selecting an informative part of a large-sized image). 

Illustrations created using MS Office are not accepted. 

With color illustrations slowing down and making the publication process costly, we accept them in exceptional cases, when topics related to color image processing are reported.
The image can have a width of up to 82 mm; or alternatively, can have a full-page width (17 cm) to avoid it being too small and illegible. 

Use TIF format for raster (half-tone) images, PNG or GIF format for black-and-white and grey images, and JPG format for color images, with 600dpi resolution. If images contain a text or sharp color contrast, the use of TIF or PNG format is preferable. Screenshots should be presented with a maximal possible resolution, enabling a sharp and high-contrast picture. 

a) [image: image4]
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Fig. 2. Illustration linkage

Vector images (schemes, diagrams, plots) should be drawn using either a CorelDraw 11-13 (CDR files) or Inkscape (SVG, 'simple SVG' format) and exported to Windows Metafile (WMF, preferable) or Encapsulated PostScript (EPS) files. Together with the manuscript, it is required to submit both *.wmf (or *.eps) files and the original *.cdr, *ai, *.svg files. Lines should be at least 0.2 mm thick. For illustrations (schemes, plots) created using mathematical or simulation software these should be submitted in two formats, namely, a vector format (CDR, AI, WMF, EPS, SVG, EMF are accepted) and a copy of the raster file (TIF, BMP, PNG), except for JPG. Submission of a vector format is obligatory. Raster schemes and plots, including scanned or traced ones, inserted in a vector file are not considered as vector files. In-figure inscriptions should be typeset in 9-point black Times New Roman Italic. 

Figure captions

Figure captions should be put after the word Fig., followed by a consecutive number, and typed in 9-point Times New Roman Italics (column-centered, 3-point left and right margins). The full stop should be used after the number and should not - at the end. 

[image: image6]
Fig. 3. Example mixed (vector and raster) illustration

The use of figure captions is mandatory.

If there are several figures under the same caption, these are denoted with letters a, b, c, etc. The in-text references to the illustrations are made as follows: Fig. 2a; Figs. 3a and b; Fig. 8a, b; Fig. 9a-d (italicized lettering).
Tables

For the in-table text, use a 9-point Times Roman font. The width may be either single-column or full-page. 
Table headings, starting with the word "Table", are centered on top of the table and typeset in 9-point Italics. If there are several Tables, they should be numbered in the order of their appearance in the text. The full stop is used after the Table number and not used after its title. 
It is mandatory to title Tables.
Bibliography
In-text references to the bibliography list should be put in brackets and separated by comma or hyphen: [1, 2], [3-5]. 
References should be numbered consecutively in the order of their citation in the body of the paper.  

The text is typeset in References style: 9-point Times New Roman font, paragraph margin 5 mm, full-column formatting, numbered.
References to unpublished materials, which have not been accepted for publication, are not allowed. Authors are requested to avoid references to the Internet literature (hyperlinks), as well as to authors' abstracts and dissertations.
Publishers with branches in other cities should be separated by a semicolon, e.g., M.; L. or Samara; Saratov. Do not put Publishers’ names in quotation marks. Names of former Publishing Houses can be abbreviated; names of modern publishers are indicated in full. Prior to the branch name, a full stop should be put. The year of publication is indicated after a comma. 

For multi-author articles, names of all contributing authors should be given.

Titles of periodicals (journals) are not abbreviated. 

The requirements for the list of References are based on the Elsevier Publishing House rules complying with WoS and Scopus requirements (examples can be found in the References section in accordance with the list below). 

1. Russian monograph [1].

2. Foreign monograph [2].

3. Monograph translated from a foreign language [3].

4. Journal article [4].

5. Article in a foreign journal [5].

6. Article in a periodical [6].

7. Article in a foreign periodical [7].

8. Scientific research translated from a foreign language [8].
9. Article in a multi-volume publication [9].

10. RF patent for an invention [10] (date of patent publication should be indicated).
11. Handbook [11].

12. Online Source (website) [12].
13. Online Source (file) [13].
(Examples of references to published works contributed to by four or more authors can be found at [1, 4, 7]).
In the References section, abbreviated journal names should be used only in compliance with the list given at the address http://issn.org/services/access-to-the-ltwa/. 
Note that References can also be presented in an arbitrary format, comprising:
-- Author(s);

-- Full title of an article/book/conference proceeding;

-- DOI (if any);
-- For journals: Unabbreviated name of the journal, volume/issue/part number, pagination (or paper's ID);

-- For books: City, Publishing House, and year of publication, pagination (or book's length);
-- For conference proceedings: Full title of the conference, part (volume, issue) number, city, year, pagination (or paper's ID);

-- For patents: code number in international classification, author(s), patent's title, applicant/holder's name, number and date of application, date of issuance, number of the bulletin;

-- For Online Sources: Authors, page/document title, page/document online address, the date of access.

If a source has a DOI, it is mandatory to give it in the References.
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Appendix
Most commonly used symbols
	“ (upper)
	Alt + 0147
	second)
	Alt + 0178 (Symbol)
	·
	Alt + 0183

	” (upper)
	Alt + 0148
	
	Alt + 0165 (Symbol)
	
	Letter «X» (Symbol)

	‰
	Alt + 0137
	
	Alt + 0182 (Symbol)
	
	Sign «@» (Symbol)

	©
	Alt + 0169
	
	Alt + 0184 (Symbol)
	
	Alt + 0186 (Symbol)

	§
	Alt + 0167
	
	Sign # (Symbol)
	
	Alt + 0163 (Symbol)

	
	Аlt + 0171 (Symbol)
	
	Alt + 0172 (Symbol)
	
	Alt + 0179 (Symbol)

	
	Alt + 0174 (Symbol)
	
	Alt + 0173 (Symbol)
	
	Alt + 0175 (Symbol)

	° (degree)
	Alt + 0176
	±
	Alt + 0177
	
	

	 (minute)
	Alt + 0162 (Symbol)
	
	Alt + 0215
	
	


Symbol codes are typed on a small numeric keypad (with "Num Lock" switched on) with English keyboard layout. Some symbols may call for the use of Symbol font.
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If it is not possible to prepare a manuscript in compliance with the current guidelines, it may be submitted 
in a 'review' format (as an unformatted text file in Word, containing all elements mandatory for a manuscript, 
and files with illustrations). In this case, the manuscript will be sent for peer review 
and then published after it has been brought in correspondence with the current rules.
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